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Find, use and share p—
research with EndNote @ .

Sign In or create an account = (B
o s -

It's for more than bibliographies. Sync your
EndNote library across your desktop, iPad and

online. Work on your research from anywhere.

Accelerate your research

EndNote is a reference manager that helps you save time

formatting citations, so you can focus on your research.

Screenshots www.endnote.com
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M1 Lib4RI

Lib4RI Training Series

o Module 1
Searching Scientific Information

o Module 2
Scientific Publishing: From Writing to Sharing

o Module 3
Open Access & Copyright

o Module 4
Literature Management with EndNote

o Module 5
Getting Started with LaTeX

o Module 6
Work on Your Own Project

o Module 7
Research Data Management — The Basics

NEW o Module 7*
Load, Work & Plot Your Data Using Python, Pandas & Jupyter Notebook
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Searching & Managing
Scientific Information

Training series

Autumn 2023

Modules:
1 Searching Scientific Information
2 Scientific Publishing —

From Writing to Sharing

Open Access & Copyright

Literature Management with EndNote

Getting Started with LaTeX

Work on Your Own Project

Research Data Management — The Basics
T+Load, Work & Plot Your Data Using Python,

Pandas & Jupyter Notebook

Course sites:
Eawag: Dubendorf
Empa: Dubendorf
PSI: Villigen

WSL: Birmensdorf
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Module 4 — Literature Management with EndNote

9.00 — 9.15 Introduction to Literature Management
9.15 — 10.45 EndNote Presentation & Live Session (Part 1)
10.45 — 11.00 Break

11.00 — 12.30 EndNote Presentation & Live Session (Part 2)
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" - formation
tion scientific
e Evalual & WManaging
. Searching

L ies:
Lip4R Training SEE ent with Endnot®

Thanks for your feedback S

Help us improve our training by
returning the feedback form enclosed
in your documentation!

The course slides and
supplementary material are available
online on our website at
www.lib4ri.ch > Learn > Trainings

o whatdidyou Be most?
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Why Literature Management & Software?
Literature / Information Sources Advantages of dedicated software
0 Books & book chapters o Import, edit, organise, sort and retrieve metadata

o Articles in journals & newspapers & media

o Conference proceedings o Access library via
o Desktop & Laptop
o Web

o Smartphone & tablet

o Web pages
o Databases

o Software

o Images, audio & video, ... o Share content with colleagues

by Meghan Dougherty, www.flickr.com, CC BY-SA 2.0

] o Use library for the writing of reports, articles,
Managing theses
o File, organise & update references (author, title, year

, _ _ o cite references in your text
...) and corresponding media (articles, books, ...)

, _ o 0 generate bibliographies
o Aim: a personal library for quick information retrieval

& usage o select / change output styles according to the

requirements

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL @ @ 6


http://www.flickr.com/
http://creativecommons.org/licenses/by-sa/2.0/

M/ L|b4R| Endnote

Reference Management Software — Features

Essential Recommended

0 Add metadata & PDFs o Built-in online search with (semi)-automatic import

o Import bibliographic information from databases & publishers of references incl. PDFs

o Add & edit manually

o Access from everywhere
o Organise references

o Type (eg article, book, ...) o PC, Mac, ...
o Metadata (authors, title, ...) o Online / Web
o Personal groups / folders

o iOS / Android

o Sort, search, tag, ...

, , o Share & collaborate
o Find duplicates

o Read & annotate PDFs o Import / export metadata (& PDFs) from / to other

o Cite references & create bibliographies in your word processor reference management software
using various (editable) styles

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL @ @ 7
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Common Reference Management Software

RefWorks

BOC ==

Bookends

EN
EndNote & MENDELEY
S E N T E 6 J abRefreference manager
zotero @

Papers Crtavi

‘W; BibDesk

... and more
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Endnote

Common Reference Management Software

(EndNote (formerly Thomson Reuters, since N
2017 Clarivate Analytics)

o Work horse for literature management (1st
release 1988)

o Full licence (desktop version PC & Mac) can be
obtained via your IT Services allowing for shared
library use of up to 200 (EN20) or 1000 (EN21)
group members

o Online web clients (limited functionalities):
New (EN21), Classic (EN20 & EN21)
endnote.com/weblogin/

\o iIOS app )

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Zotero (open source)

o Desktop version (PC, Mac, Linux) with web connectors
(Firefox, Chrome, Safari, Opera) and online web client
(limited functionality)

o Free < 300Mb online storage (expandable $, Dropbox
capable)

0 www.zotero.org

Mendeley (Elsevier)

o Desktop version (PC, Mac, Linux) with web
connectors (Firefox, Chrome, Safari, IE)

o Strengths in sharing / networking / online
collaboration

o Free < 2Gb, < 5 private groups, < 25 group
members (cloud space expandable, $$)

o www.mendeley.com

©@® 9
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Introduction to EndNote 20

EN’s GUI
o Create a new library (11)
o Graphical User Interface (12)
Collect
o EndNote’s built-in online search (16)
o Export / import after an external database search (19)
o Import metadata from PDFs (24)
o Manually adding & altering references (25)
o Find & attach full text PDFs (27)
Organise
o Building groups (31)
Checking & Updating references (32)

(@)

Finding duplicates (33)

(@)

Searching references (incl. PDFs & annotations) (34)

(@)

Backing up your library (35)

(@)

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Endnote

Cite
o Bibliographic output styles (37)
o Cite-while-you-write
(MS Word) (42)
o Using journal abbreviations (46)

Share & Sync

o Without EN Online Account (50)
Share references via E-mail
Share travel library via Word plugin
Share library as a compressed library or via servers
o With EN Online Account (53)
Sync between your devices
Share entire library
Share groups
Concluding Info, Help & Useful Links

o EndNote can do more (58)
o Is EndNote the right thing for me (59)

o User Guides & Tutorials, Support / Knowledge Base,
Community, FAQ (61)

O® 10



MV Lib4RI Create a New EndNote Library Endnote

D EndNote X8
References  Groups Teools Window Help

Maximize your time Open Library... 0
Open Shared Library... Ctrtl+Shift+ 0
e
Open Recent k
Share yOUI’ |ibl’ary @ New Reference Library
@n‘\;‘;v| J ¢ Module4-Endnote » Libraries » v|¢,|| Search Libraries [P

=
File name: Training Library.enl

Welcome to EndNote

Save as type: ’EndNote Library (*.enl)

Get started by setting up your EndNote account

An EndNote account lets you access your research from
anywhere, anytime - from your desktop, online or on your iPad

£l

o Tip: EndNote generates an *.ENL file and
a *.DATA folder that need to stay together.
@) o Tip: While the *.ENL file is the library with
all metadata, the *.DATA folder is the
default location for attachments and also

EndNote™ L

contains library related indexing files.

When EN opens for the first time a welcome screen might ask you to setup an online account.
There is no need to do this now. Just create a new or open an existing library via the <File> menu.

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL @ @ 11
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End

File Edit References Groups Library Tools Window Help

> Sync Configuration

B All References
A Recently Added
B Unfiled

W Trash

v MY GROUPS

v My Group Set
& Just something to show

> FIND FULL TEXT
> GROUPS SHARED BY OTHERS

~ ONLINE SEARCH
@ PubMed (NLM)
@Web of Science Core Colle...

more...

Groups pane
(organise)

Search for group

Just something to show

The Graphical User Interface — Main View

Search panes

8 .., 2002 ... (Summary) edit PDF  x

Endnote

Advanced search

Esper-2002-Low-frequency si... ~

Just something to show

2 References

RLAN®)

Low-frequency signals in long tree-ring

Author Year

Title

Reference Type

Journal chronologies for reconstructing past

Einstein, Albe... 1963

Esper, J.; Coo.. 2002

The evolution of physics the ...

Low-frequency signals in long...

Reference list pane

(sort & find)

Journal Article

temperature variability

J. Esper, E. R. Cook and F. H.
Science Schweingruber

Science 2002 Vol. 295 Issue 5563 Pages
2250-2253

Acces Tabs pane 240
POk (summary, edit, PDF)

Preserving multicentennial climate
Srariability in long tree-ring records is

vd

ﬁm 6th -

| nsert ‘ ‘ Copy ‘ \

Esper, J., Cook, E. R., & Schweingruber, F. H.
(2002). Low-frequency signals in long
tree-ring chronologies for
reconstructing past temperature
variability. Science, 295(5563),
2250-2253.

Output style with
preview (only in
summary pane)

doi:10.1126/science.1066208 j
JIN\_

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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The Graphical User Interface — Main View

E E..., 2002 #345 Summaryl Edit I-’DF X

sarch

nal

nce

Reference Type Journal Article v
Author  Esper, J.
Cook, E. R.
Schweingruber, F. H.
Year 2002
Title  Low-frequency signals in
long tree-ring chronologies
R_eference for reconstructing past
Fields temperature variability
Journal  Science
Volume 295
Part/Supplement
Issue 5563
Pages 2250-2253

gure
Film or Broadcast
Generic

Government Document
Grant

Hearing

Interview

v Journal Article

[ o W P

Legal Rule —-
Magazine | Types
Manuscript

Map

Multimedia Application
Music

Newspaper Article

Online Database

P 0 RA_lac 12

Tip: Don’t change the
formatting here. It will
overrule the formatting
defined by the <Output
Style>

)
Reference

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Each reference is
associated with a
<Reference Type>, eg
<Journal Article> and
contains in its <Fields>,
the metadata, eg
<Author>

Each <Output Style>
uses this information to
generate citations and
a bibliography in your
document

©@®

Endnote
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E E..., 2002 #345 Summary

Edit| PDF

1 QB —|50% |+ OC

X
& o]

o B

/5 v —

The Graphical User Interface — PDF Viewer

Endnote

Esper-2002-Low-frequency signals in long ...

REFORTS

Low-Frequency Signals in Long
Tree-Ring Chronologies for
Reconstructing Past
Temperature Variability

Jan Esper,” Edward R. Cook,™ Fritz H. Schweingruber’

Preserving multicentennial climate variability in long tree-ring records is crit
ically important for reconstructing the full range of temperature variability over
the past 1000 years, This allows the putative “Medieval Warm Pericd” [MWP]
to be described and to be compared with 20th-century warming in modeling
and attribution studies, We demonstrate that carefully selected tree-ring chro
notogles from 14 sites in the Northern Hemisphere [WH) extratropics can
preserve such coherent large-scale, multicentennial temperature trends if prop
er methods of analysls are used. In addition, we show that the average of these
chronologies supports the large-scale occurrence of the MWP aver the NH
extratropics,

4

... PDF is
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tructing the full range of temperature variability over

val Warm Period” (MWP)

rom 14 sites in the Northern Hemisphere (MH) extratropics can
eserve such coherent large-scale, multicentennial temperature trends if prop-

er methods of analysis are used. In addition, we show that the average of these
chronologies supports the large-scale occurrence of the MWP over the NH

extratropics.

Much of the current debate on the Earth’s cl
mate variability is driven by the observation of
a modern, century-long temperature increase,
culminating with the last decade of the 20th
centwry as the warmest since 1856 (f). These
dramatic recent temperature changes have been
related to those of the last millennium by the
Mann-Bradley-Hughes (MBH) multiproxy re-
construction of NH annual temperatures (2). By
combining instrumental temperature data with
long, temperature-sensitive proxy records, the
MBH reconstruction indicates that the 20th-
century warming is abrupt and truly exception-
al, It shows an almost linear temperature de-
crease from the vear 1000 to the late 19th
century, followed by a dramatic and unprece-
dented temperature increase to the present time,
The magnitude of warmth indicated in the
MBH reconstruction for the MWP, ~1000
1300 (3, 4), is uniformly less than that for most
of the 20th century.

The MBH reconstruction has been criticized
(5) for its lack of a clear MWP. Critics argue
that tree-ring records, the substantial basis of the
MBH reconstruction before the 17th century,
cannot preserve long-term, multicentennial tem-
perature trends. This contention is of fundamen-
tal importance because 1f tree-ring reconstruc-
tions are limited in this way, then including such

distributed over a large part of the NH extrat-
ropics (Fig. 1). Tree species represented in this
collection are from the genera Picea, Pinus,
Larix, and Abies, Using these d:

These growth trends occur almost universally
in “raw’” tree-ring measurement series and fre-
quently

1 8

e ...0r in a separate window.

trending

=t COmments, annotations,

¢
climati¢

wae Printing and emailing is

trended 5
ring sef I
ey possible
explicitiy ucuuinnu vy a o EUwva v
Consequently, the problem of missing long-
term trends in millennia-length tree-ring chro-
nologies is due to using detrended series that
are short relative to the multicentennial fluctu-
ations due to climate (8). Exceptions are chro-
nologies built with 1000 year or longer individ-
ual tree-ring series (9, J0) and chronologies
developed by Regional Curve Standardization
(RCS) (/1) or Age Banding (/2) methods.
Several of the tree-ring collections analyzed
here have been described and used previously
in individual and large-scale temperature recon-

strate that multicentennial temperafure informa-
tion can be preserved in long trediring records
provided that the data are properlyfprocess:
preserve such low-frequency inforfhation di
climate. We also show that the MVEP was likely
to have been a large-scale phenofenon in the
NH extratropics that appears
proached. during certain intervals. the magni-
tude of 20th-century warming, at least up to
o0

f  Most millennia-long tree-ring chronologie
are averages of many tree-ring series from liv-
ing and dead trees. The segment lengths of
these series are typically 200 to 400 years long,
and the overlapping individual series are exact-
ly aligned by calendar year and connected in
time using a method known as “cross-dating”™
(6). The difficulty of preserving mulficenten-
nial variation in such tree-ring series, when the
segment lengths are substantially shorter than
the length of the overall chronology being de-
wveloped, results from the removal of age-related
biological growth trends that represent noise for
the purpose of climatic reconstruction (6),

and related studies (11, 13-79), Ring
widthsfpf trees growing in cold environments
usuallyff reflect the influence of warm-season
temperfjtures on growth most strongly. Howev-
Ime cases, they also reflect temperatures
from tif: cool-season months before the radial
growthliseason as well (20). Here, we will not
flly model the remperature signals of the
individual tree-ring chronologies, because this
has mostly been done already (11, 13-19).
Rather, we will demonstrate the preservation of
coherent multicentennial variability among the
14 tree-ring sites, which is inferred to reflect
large-scale, multicentennial temperature chang-
es over the past 1000 years in the NH extrat-
ropics. The:

inferred changes are almost cer-
tainly hted  toward  the
months, as some previous studies have shown
(11,13, 18, 19). Even so, low-frequency warm-
season and annual temperature trends recorded
in NH instrumental data
tinguishable (&).

To preserve possible  multicentennial
growth trends due to climate, we analyzed the
individual raw ring-width measurements using

rm-season

©@®
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Introduction to EndNote

EN’s GUI

o Create a new library (11)

o Graphica&lnterface (12)
Collect

o EndNote’s built-in online search (16)
o Export / import after an external database search (19)
o Import metadata from PDFs (24)
o Manually adding & altering references (25)
o Find & attach full text PDFs (27)
Organise
o Building groups (31)
Checking & Updating references (32)

(@)

Finding duplicates (33)

(@)

Searching references (incl. PDFs & annotations) (34)

(@)

Backing up your library (35)

(@)

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Endnote

Cite
o Bibliographic output styles (37)
o Cite-while-you-write
(MS Word) (42)
o Using journal abbreviations (46)

Share & Sync

o Without EN Online Account (50)
Share references via E-mail
Share travel library via Word plugin
Share library as a compressed library or via servers
o With EN Online Account (53)
Sync between your devices
Share entire library
Share groups
Concluding Info, Help & Useful Links

o EndNote can do more (58)
o Is EndNote the right thing for me (59)

o User Guides & Tutorials, Support / Knowledge Base,
Community, FAQ (61)
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End
File Edit

Library

©Sync Configuration

[E All References
LA Recently Added
B Unfiled

WTrash

v MY GROUPS

v My Group Set

& )ust something to show
> FIND FULL TEXT
?> GROUPS SHARED BY OTHERS

v ONLINE SEARCH
@ PubMed (NLM)

@Web of Science Core Colle...

Tools

Output Styles
Import Filters

Window Help

[ConnectionFiIes ]

Cite While You Write [CWYW]

Format Paper

Subject Bibliography...

Show Connection Status

Convert HTML Tags

Online Search...

Via the Connection Manager,
Mall EndNote Click Browser 8- dgtabase connections need to
be activated

3

3

3

Collect Metadata — EN’s Built-in Online Search
& Connection Files

New Connection...
Edit "Web of Science Core Collection (Clarivate)”
Open Connection Manager...

Title

Esper, J.; Co...

2002

The evolution of physics the growth of ideas from early

Low-frequency signals in long tree-ring chronologies fc

supported

o By default, PubMed & Web of Science are activated; many library
catalogues available

o Connection file to our library catalogue swisscovery. Scopus is NOT

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Endnote

EndNote Connections
File Edit Tools Window Help
Mame Information Provider 2
[] swinburne U of Tech Library Catalogs
|_| ‘i'i'iii En; Il MiEr.:d-inn | i
Swiss Library Service Platform (s...  Library Catalog I
LI Swiss Matl Library Library Catalogs W
Get More an the Web. .. Mark All Unimark All Find by *
F More Info:
Showing 6006 of FA7E ~=mmamtinm &Elam _
1 Certain connection files (eg r

swisscovery) need to be
downloaded from the web and
installed via double-click.

Use the Connection Finder below to search for a specific Information Provider.

Swiss library service platform

1 results found

Information Provider

Swiss Library Service Platform (swisscovery)
Library Catalog
2021-07-19
Download

(DIO) 16



wnig  Collect Metadata — EndNote’s Online Search (swisscovery)

Endnote

jps Library Tools Window Help
Swiss Library Service Platfo... s 2. Submit Your
Search Query

© Sync Configuration

[

|E = ..., 2007 ... Summary Edit PDF X
B All References 2 ‘And vHYear vHContainSvH |E v a

QRecently A i ‘And v‘ ‘Title keywords v| ‘ Contains v‘ ‘Statistics | E ”
E uUnfiled Reference Type Book v

W Trash 0 X Clear search Search options ~

> MY GROUPS

‘Author (last name first) VHContains v‘ ‘Freedman

Author  Freedman, David
Freedman, David

Searching Swiss Library Service Platform (swisscovery) @ 4. Add selected reference @ Pisani, Robert
tetrieve results: 15 i Purves, Roger
Retrieve result 3. Select to your library

> FIND FULL TEXT

. Choose swisscovery 48
v ONLINE SEARCH

S PubMed-(NLM) e ®  Freedman,.. 2007 Statistics Book Int Statistics

@ Swiss Library Service Platf... 15

m author - Reference peference e | 100l Vear 2007

Freedman, ... 1998 Statistics Book series Editor

|
@ VWED 01 dLlence Lore Lole.. u
O

Freedman, .. 1998  Statistics Book Series Title  International
student edition

MOre...

E All References

A Recently Added
...et voila & Unfiled : All References

3 References

WTrash

> MY GROUPS p Author Year Title Referer

> FIND FULL TEXT Freedman, .. 2007 Statistics Book

Library for the Research Inst > 17
Y GROUPS SHARED BY OTHERS Esper, J.; Co... 2002 Low-frequency signals in long tree-ring chronol...  Journal




MV Lib4R] Collect Metadata — EndNote’s Online Search (Web of Science
<Lore Collection

Endnote

Groups Library Tools Window Help
Web of Science Core Colle... &S 2. Submit Your
Search Query

< Sync Configuration

vHContains vHMiIne

\Author{Smith,A.B.} ‘E B .., 2004 .. Summary Edit PDF X

B All References ‘And v‘ ‘Year (limiter only) VHCor'ltains VH ‘ E A

ﬂ ~
e ‘And v‘ ‘Title v‘ ‘ Contains v| ‘Carbon nanotubes as field emission sources ‘ E
Bl Unfiled Carbon nanotubes as field emission

i sources
WTrash 0 X Clear search Search options ~ m

> MY GROUPS : W. I. Milne, K. B. K. Teo, G. A. .

> FIND FULL TEXT Searching Web of Science Core Collection (Clarivate) 4. Add selected reference @ ';‘”;if;‘e‘l'l‘geat' :I Legagneux, L. Gangloff, J.
] Retrieve results: 1 3. Select to your library ' o
1. Choose Web of Science Journal of Materials Chemistry 2004 Vol. 14
[l Ayt s Wim o Reference D mfmramma Tusy L rm ol
~ ONLINE SEARCH ey Issue 6 Pages 933-943
@ PubMed (NLM) 0 &  Milne.. 2004 Carbon nanotubes as field emission sources  Journal Article ILINEIRGRVEIENEIIOENEOWN . ion Number WOS:000220096200007
S CriermbrarySerdeeRigt—it DOI: 10.1039/b314155¢
@web of Science Core Colle... -
Micro and nano-structurally rich carbon
[l All References : Advanced searc
L Recently Added :
B Unfiled 23l All References 274
A + Q
...et voila Wl Trash ) 4 References
> MY GROUPS c Author Year Title Reference Type  Journal
> FIND FULL TEXT Freedman, D... 2007 Statistics Book International student edition

> GROUPS SHARED BY OTHERS

Milne, W. I; T... 2004 Carbon nanotubes as field e... Journal Article Journal of Materials Chemistry
v ONLINE SEARCH

Library for the Research Institutes within't Fener |* Con 2002 | nw-frennencv <innals in lonn lnurnal Article _ Srienre
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Collect Metadata — External Database Search & Import (Scopus)

Endnote

1 Scopus

6,488 document results

TITLE-ABS-KEY ( ozone AND ( wastewater OR "waste water"))

# Edit @ Save L. Setalert

Search within results... Documents

o 2 H

Search Sources Lists SciVal »

Create account

1. Search query

Secondary documents  Patents

View Mendeley Data (244)

Refine results

0llo Analyze search results

Show all abstracts| Sorton: Cited by (highest)

2. Select & export

. I Export EFwnload View citation overview  View cited by ~ Add to List = 2 = ¥
e.g. the top 3 cited -
Open Access N Document title Authors Year Source Cited by
DA” Open Access (934) > |i| 1 | Recent developments in photocatalytic water Chong, M.N., Jin, B., Chow, C.W.K., 2010 Water Research 3502
[]Gold (285) > treatment technology: A review Saint, C. 44(10), pp. 2997-3027
«
[ Hybrid Gold (130) > View 4l -
Export document settings @
DBronze (280) > |
[]Green (483) > @2 |Arevie You have chosen to export 3 documents 2107
advan
Learn more Select your method of export 3 SeIeCt RIS format ‘
(O A MENDELEY - (D extibns (@) RIS Format Ocsv (OBibTex () Plain Text
Year A View al RefWorks EndNote, P s s s Taa
e w s reference anager 1 @nd include citation, bibl.
1 .
[ 3 |Decon info and abstract/keywords 2067
[J2022 (98) > photol What information do you want to export?
o0, s

1

[®] Citation information [®] Bibliographical information [9] Abstract & keywords

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI &
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MV Lib4RI Collect Metadata — External Database Search & Import (Scopus)

EndNote 20 - Training Librarv.en
S RIS-files can be automatically imported into the library
via double-click (if RIS is associated with Endnote)

r I'IIJUI (R W B R wry pur) ) B L e |

< sync Configura NI R = group
<Imported References>

E All References Advanced search

® Imported References 3
- Imported References A

%RELEI’IHY Added : p:l.:;:. e &| @

B Unfiled » nelerences

WTrash

Author Year Title Reference Type  Journal

> MY GROUPS

Chong, M. N.... 2010 Recent developments in phot... Journal Article Water Research
? FIND FULL TEXT

Malato, S.; Fe... 2009 Decontamination and disinfe...  Journal Article Catalysis Today
> GROUPS SHARED BY OTHERS

Neyens, E.; B... 2003 A review of classic Fenton's p...  Journal Article Journal of Hazardous Materials
v ONLINE SEARCH -
Or import the RIS-file - i — o Tip: Many other import options/filters
manually via “File > are available and can be activated via
Import > File” and the | {_ mort opton [Reference Menager (29 - “Tools > Import Filters > Open Filter
appropriate <|mp0rt dicates: Discard Duplicates b ”
Option> pupletes Manager
Text Translation: Unicode {LITF-8) i
Impaort Cancel

Library for the Research Institutes within the | @ @ 20
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* Articles

Any time

Since 2022
Since 2021
Since 2018
Custom range. ..

Sort by relevance
Sort by date

Google Scholar

Clifford Complexation of Constrained Ligands Piperazine] E \

Cite

Complexation of constrained li

and thiomorpholine

SE Clifford, V Tiwow, A Gendron. .. - Austr

Complexation of the symmetric cyclic diami
examined in dry dimethyl formamide by spe
define formation constants, and by stopped
and reaction pathway. Initial formation of ar
occurs In a rapid second-order reactions. T

reactionsgfermretrens, of (chelated) n2-pipera
Y¢ Save| 99 Cite |Cited by 4 Related a

Save As

Copy and pasie a formatted citation or use one of the links to import into a bibliography
manager.

MLA Clifford, Sarah E., et al. "Complexation of constrained ligands piperazine, N-
substituted piperazines, and thiomorpholine.” Australian journal of chemistry
6210 (2009): 1196-1206.

APA  Clifford, S. E., Tiwow, V., Gendron, A_, Maeder, M_, Rossignoli, M., Lawrance,
G. A, ... & Schroeder, M. (2009). Complexation of constrained ligands

piperazine, N-substituted piperazines, and thiomorpholine. Australian journal of

chemistry, 62(10), 1196-1206.

Chicago Clifford, Sarah E_, Vanny Tiwow, Aleasia Gendraon, Marcel Maeder, Monica
Rossignoli, Geofirey A. Lawrance, Peter Turner, Alexander J. Blake, and Martin

Schroeder. "Complexation of constrained ligands piperazine, N-substituted
piperazines, and thiomorpholine." Australian journal of chemistry 62, no. 10
(2009): 1196-1206.

BibTeX] EndMNote |JRefMan RefWorks

QQ | » Neuhold, Bobby » Downloads

- | 5 | | Search Downloads

File name:

scholar.enw

Save as type: [EndNute Import File

* Browse Folders

L

Save

| [ conct ENW-files can be automatically imported

into EN’s library via double-click

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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miLibipy  Collect Metadata — External Catalogue Search & Import (swisscovery)

Endnote

& Journals by ) mumE' o
llb‘Rl”f swisscovery New Search category Databases Lib4RI wes B3, ’ Signin Menu w

freedman statistics X swisscovery ¥ ADVANCED SEARCH

All items that contain my query words anywhere in the record «

Sign in to get complete results and to request items 'El Sign in X DisMIss
Activ 7 B ¢ & X
ey Statistics

List of " Freedman, David 1938-2008

8- - New York : WW Norton & Co

o 4th ed., international student ed. - [2007]

B’ Check for available services »

Twez

D Int B B q . q ﬁ L‘:P
ful Export RIS E;e:pljrtB.:-inTe:I: Exporttd Tlp If requested’ ail Frint Permalink

Sort by Date-newest ¥ oy zliw Yorl;;;;& seIect_UTF-8
Export RIS-file and import to Endnote ..o, . encoc_jlng for
via File > Import > File > Reference RIS-file export

Manager (RIS) or by double-click

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL @ @ 22



MW LibéRI Collect Metadata — External Catalogue Search & Import (Publisher) e

&) Springer Link :
- ‘ Cite entry A
~ o Tip: Citations for
Springer Handbook of Mechanical Engineering pp 1149-1266 | Citg How o cite? book chapters
are often best
Construction Machinery L RIS obtained via the
D - publisher’s
P website
Authors Authors and affiliations Reference Manager
_ RefWorks
Eugeniusz Budny >, Mirostaw Chtosta %], Henning Jiirgen Meyer
Zotero
Reference work entry 5 e i ENW
Readers Downloads EndNote
, L .BB
BibTeX
Book chapter (doi: 10.1007/978-3-540-30738-9) | JabRef
Mendeley
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M1 Lib4RI

| Double-check EN’s PDF filename settings

EndNote Preferences Via Edit > Preferences > PDF Handling

- Change Case

- Display Fields

- Display Fonts

- Duplicates

- Find Full Text

- Folder Locations
- Formatting
—EaTRE

™ PDF Handling

- Reference Types

- Sorting
- Spell Check
- Sync

- Termnporary Citations

(FDF Auto Renaming Options \
") Don't Rename

@ Author + Year + Title
(7 Author + Title

() Author + Year

i) Title

() Custom

Collect Metadata — Extract Metadata from PDFs

Existing PDF-files (incl. its metadata)
Import File | Can be imported via File > Import > File

Endnote

,
Import File: IESper—muz'de Choose...
Import Option: FOF -

\

Duplicates: | Discard Duplicates -]
Text Translation: [Unimde (UTF-8) v]

[ Import ]

k Mote: Filenames may be up to 50 characters long. )

v Tip: PDF-file renaming can also be done later,
even as a batch, via References > File
Attachments > Rename PDFs

% Tip: DOI needs to be present to allow for the
extraction of metadata from PDFs

| Existing PDF annotations are kept during import

\ 4

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

i, M

., 2002 ... Summary Edit PDF X

U X' X Q

Save

Reference Type

Author

Year

Title

Journal

Volume

Part/Sunnlement

Journal Article v

Esper, J.
Cook, E. R.
Schweingruber, F. H.

2002

Low-frequency
signals in long tree-
ring chronologies
for reconstructing
past temperature
variability

Science

295




MV Lib4RI Collect Metadata — Manual Addition of references

EndNote 20 - Training Library.en

File Edit References Library Tools Window Hs

' Mew Reference ' Ctrl+MN

Edit Reference

New Reference (Training Library....
File Edit References Groups Library Tools

Window Help

E-mail Refereni g
= Edit PDF
Move Referenc _I

File Attachmenl B 7 Y X' X Q

Find Full Text -

Find Reference Reference Type  Journal Article y
URL I Author  Cai, J.
Figure

Year 2010

Web of Science I
' Title  Atomically precise '

Reference 5um bottom-up fabrication

2 GRO| "

Journal  Nature '

References can be
added manually and
associated with a upplement

<Reference Type> '
- Issue 7305

Volume 466

Pages 470-473
Library for the Research Institutes withinthe"ETrH"DomainEawag; " Empa; PSIr&rvwsE

o For the manual addition of
references you need to obey a
certain syntax and rules regarding
the input of the metadata into the
respective fields

o Rules are pretty straightforward
and their effect (for a given output
style) can be seen in the bottom
section of the summary tab

o Tip: Compare your syntax with some
already existing (imported) references of
the same reference type

o Tip: EN’s built-in Help index (F1) gives
advice on entering references manually

|E§E] EndMote

e = &
Hide Back Forward  Print

: : Entering References
Type in the keyword to find:

Bibliographic information (as well as k

into separate fields in each Endhote r

different fields, EndNote can later rear

formats (such as APA or MLA).

Calmed Toarmis o e = e

Endnote
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MV Lib4RI Collect Metadata — Manual Alteration / Editing of references Endnote

B ..., 2007 ... Summary Edit PDF x{

Metadata as imported
from swisscovery

r

Reference Type Book v B /7 U X' X Q
e.g. delete

Author  Freedman, David name
Freedman, David

B/ UXX Q B .., 2007 ... Summary Edit PDF X

Keywords Mathematical

o duplicate)
Pisani, Robert statistics Textbooks
Purves, Roger . -
Statistique
Year 2007 Statistik
. L lehrblcher
Title  Statistics [d kumententy’ }
_ 0
bort - o Tip: Always check mathematischep
r? ol 71pproptr_|a € imported metadata mbmaios
changes CO:;’[L?dct:er:tO;iion for correctness & ...or you might want to
| suitable field syntax. add your own keywords
Place Published New York stochastische
Publisher W.W. Norton & Co. prozesse
(mathematik)
Volume Mathematical
e.g. statistics
Number of Volumes delete S. Statistik 0
Series Volume (German
abbr. for Gesamtdarstellung

| Number of Pages 576 S. | pages) Lehrbuch
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winr  Find & Attach Fulltext PDFs

Change Case
Dis.pla}r Fields
- Display Fonts

.. Find Full Text \
— Folder Locations

- Formatting

.. Libraries

. PDF Handling
.Read / Unread

- Reference Types
- dorting

Double-check EN’s <Find Full Text> settings &
via Edit > Preferences > Find Full Text

The Find Full Text feature uses several technologies to maximize the
chances that EndMote will find all available PDFs. Use this screen to
control these full text search options:

( Web of Science Full Text Links
DOI (Digital Object Identifier)
PubMed LinkOut {U.5. Mational Library of Medicine)

[+] OpenURL

OpenURL Path: |hittps://slspdib4n primo exlibrisgroup .com/openur /4151

\.

J

0] enU_RL Path (Lib4RI’'s Link Resolver):
.. Spell Check P
Sync https://slsp-lib4ri.primo.exlibrisgroup.com/openurl/41SLSP_LIB/41SLSP_LIB:GO?

- Temporary Citations

;----Terr'n Lists
t.. URLs & Links

Examples: https://login.ezproxy library myuniversity edulogin
http://auth universityname edu/authentication

[ ] Automatically invoke Find Full Text on newly-imported references

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

©@®
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MV Lib4RI

Find & Attach Fulltext PDFs — EN’s <Find Full Text>

MNew Reference

Edit Reference

Library Tools

Copy References _06\:\0

Copy Formgigey!

E-ma rence

cerence

Move References to Trash

File Attachments

Find Full Text ]

Library for the R¢

Find Reference Updates

URL

Figure

® Imported References

A Recently Added
B Unfiled
W Trash

> MY GROUPS

v FIND FULL TEXT
B Found PDF
[@ Not found

Window

Ct End

Help

Note might even be able to find

o Tip: Use EN’s PDF file auto-
renaming (see Edit >
Preferences > PDF Handling)

& attach (licensed) full text PDFs

Ct for your selection of references.

Note: This does not always work

Ctr with

-

<Science Direct Journals>

Lteferences

( FindFulTed )

Authenticate...

...be patient, finding & downloading
might take a little while and
sometimes needs to be repeated for
the ones not found

Endnote

The fields <File Attachments> &
URL are populated accordingly

?> GROUPS SHARED BY OTHERS

> ONLINE SEARCH

v AUThOr ear Title
} L — = S . —
Find Full Text >
Q
10 References &l @
Author Year Title Reference Type  Journal
Chong, M. N.... 2010 Recent developments in photocata... Journal Article Water Research

C

Check the group <Found PDF> for
successfully attached full texts. A

1 clip indicates full text is attached.

Currorg, >ara...  20uY Lompiexation oT constrainea lgan...
Budny, Euge... 2009 Construction Machinery

Freedman, D... 2007 Statistics

Milne, W. I; T... 2004 Carbon nanotubes as field emissio...

Journal Article

Journal Article

Journal Article

Book Section

Book

Journal Article

Nature

Catalysis Today

Australian journal of chemistry
Springer Handbook of Mechanig
International student edition

Journal of Materials Chemistry

Notes

Research Notes

r

URL

File Attachments

. N
https://doi.org/10.1
007/978-3-540-307
38-9 14
https://link.springer
.com/content/pdf/1
0.1007%
2F978-3-540-30738
-9 14.pdf

Budny-2... v

+ Attach file

J




MV Lib4R] Find & Attach Fulltext PDFs — Lib4RI’s swisscovery Link

Endnote
Resolver

Llhl{m”’ swisscovery E"-:{Ej ;
A Recently Added Not found
B Unfiled 7 References Complexation of Constrained Ligands

. . —u Piperazine, N-substituted Piperazines, and |
WTrash : A = e Online e
Right click a reference | ’ Get the PDF via Lib4RlI's
> MY GROUPS : and goto OpenURL Link | Full text availability swisscovery link resolver, ...
v FIND FULL TEXT OpenURL Link CSIRO Journals A
Available from 03/01/1948 volume: 1 issue: 1.
Ma Open URL

Subscribed content, provided by Lib4RI. Access is

Found PDF
restricted to the netwark of Eawag, Empa, PSI &
[@ Not found ' Clifford, Sara... 2009 s

For those <Not Found>, Lib4RlI’s
swisscovery link resolver may
prOVide help tO get to the fU” text Complexation of Constrained Ligands Piperazine, N-

substituted Piperazines, and Thiomorpholine

Freedman, D... 2007

...oruse Lib4RI’s

By: Clifford, Sarah E.; Tiwow, Vanny; Gendron, Aleasia; et al.

drag'n drop the AUSTRALIAN JOURNAL OF CHEMISTRY Volume: 62 Issue: 10 searchbox
e .., 2009 .. Summa(fEdE S ' : Pages: 1196-1206 Published: 2009
: lj PDF into the <File —
: o)
B /7 UX X Q AttaChmentS> complexation constrained ligands piperazine
RESEQTCIT MOTES - section of the
. = Aricles Journals Books Reference Institutes More
URL <Edit> tab

File Attachments Clifford-... ~ x —
+ Attach file i “‘Z’"ZG ...or file a docdel
ifford-20... T Ly .
of constrai.. Document Delivery Service (only tnr \ request
members of Eawag, Empa, P5I & WSL)

If not available in swisscovery
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MV Lib4RI

Introduction to EndNote

EN’s GUI

o Create a new library (11)

o Graphica&lnterface (12)
Collect

o EndNote’s built-in online search (16)
o Export / import after an external database search (19)
o Import metadata from PDFs (24)

o Manually ?ing & altering references (25)
o Find & attach full text PDFs (27)

Organise
o Building groups (31)
Checking & Updating references (32)

(@)

Finding duplicates (33)

(@)

Searching references (incl. PDFs & annotations) (34)

(@)

Backing up your library (35)

(@)

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Endnote

Cite
o Bibliographic output styles (37)
o Cite-while-you-write
(MS Word) (42)
o Using journal abbreviations (46)

Share & Sync

o Without EN Online Account (50)
Share references via E-mail
Share travel library via Word plugin
Share library as a compressed library or via servers
o With EN Online Account (53)
Sync between your devices
Share entire library
Share groups
Concluding Info, Help & Useful Links

o EndNote can do more (58)
o Is EndNote the right thing for me (59)

o User Guides & Tutorials, Support / Knowledge Base,
Community, FAQ (61)

O® %



MI'LibsRI  Organising your Library — Grouping References Endnote

...or have references filed into

Smart Group -— - smart groups automatically

EndNote 20 - Training Library.en
File Edit Refe &SeNsEN Library Tools Window Help Smart Group Name:  [My best papers
Create Group Rating - Is - | e e e
Create Smart Group... i _
And - Year + Contzains -
'S - : Create From Groups..
~ Sync Config b | ae | e « | contgins .
_ Rename Group
E All Referen N | [[create | [ cance Options... »
IACEY Delete Groun
|§| UﬂfllE‘d Share Group... - o i
ndMaote 20 orary.en
W Trash ) ) o
Add References To 4 File Edit References Groups Library Tools

v MY GROU Remove References from Group Ctrl+D

Create Group Set © Sync Configuration

v My Gro
: Delete Group Set

1ot o B All References
— Create group(s) and drag’'n drop | ererences

<Unfiled> references in there

Manuscript Matcher

A Recently Added
B Unfiled

WTrash ...or create a whole new group set
with new groups therein

o Tip: Work with one library only and rather assign references to groups suiting e
your different purposes (eg your different papers, theses, ... v My Group Set

o Tip: One reference can be a member of multiple groups (no duplicates are @ Just something to show
created) @ Training

vYet another Group Set

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL |Yet another group 31




M1 Lib4RI

g ..., 2007 ... Summary Edit PDF X

Save

Freedman, David
Freedman, David
Pisani, Robert
Purves, Roger

B/ UX X Q

Author

Year 2007

Title Statistics

Series Editor

International
student edition

Series Title

Place Published New York

4

Check references for “obvious” typos

or issues, e.g., swisscovery often exports into
the field for <page numbers> the German
abbreviation “S.” for pages

Series Volume

l Number of Pages 576 S. I

Organising your Library — Checking & Updating References

Endnote

Available Updates

My Reference

M

Reference Type Journal Article | Update AlFields ->

| Update Empty Fields > |

Author

| EditReference ->

Select one or more references in your
library and try to find available updates via
References > Find Reference Updates

Reference Type
Author
Year

Title

Journal
Volume

Part/Supplement

Save and Continue

Journal Article

2010

Mature

466

save manually).

incomplete references

o Tip: If you don’t want to update all or empty fields only; you can also
just copy / paste individual fields via <Edit Reference> (requires to

o This tool is particularly handy for updating manually input and

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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MV Lib4RI Organising your Library — Finding Duplicates Endnote

j Via Edit > Preferences, set the

il prereenee. | Criteria to detect duplicates | % o Tip: EndNote assigns unique and
increasing record numbers (e.g. below,
- Change Case 4 N\ #350 and #360) to all references. This can
- i i C refi based on the following fields: : : : “ ”
Display Fields mz: = - become handy to quickly identify a “later
ar . “« ” .. .
| Duplicates ] Year duplicate from an “early” original without
- find Full Text Title having to double-check all fields.
.. Folder Locations [] Secondary Title {Joumnal)
- Formatting [] Volume ) ) ) )
-~ Libraries E lssue 9 Via Library > Find Duplicates,
. Panea 0
- PDF Handling i _ ~ start the search for duplicates
. Read / Unread o Find Duplicates
Criteria
RE’FF{FEHCE T}"FI'ES D Exact Match Comparing 1and 2 of 2 duplicates. . . Skip Cancel
SDrtmg @ | ) 4 ctuati ele 2 recor . The record not selected will be moved to the Trash. xt set of duplicates.
SIFI-E” Check gnare spacing and punciuation Keep This Record Keep This Record
X \_ Y
- yNe Neyens, 2003 2350 Meyens, 2003 £360
- Temporary Citations — P
. Term Lists Reference Type Journal Article Reference Type  Journal Article
- LURLs & Links
Author  Neyens, E. Author  Neyens, E.
Baeyens, J. Baeyens, J.
o Year 2003 Year 2003
For all found duplicates,
decide which record to keep Title A review of classic Title A review of classic
Fenton's Fenton's
peroxidation as an peroxidation as an
advanced advanced
nvidatinn v nvidatinn

Added to Library: 10/02/2022  Last Updated: 10/02/2022 Added to Library: 22/02/2022  Last Updated: 22022022
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MV Lib4RI

EndNote 20 - Training Library.enl

© Sync Configuration
B All References
A Recently Added
B Unfiled
W Trash
v MY GROUPS

v My Group Set

& Just something to show

@ Training

v Yet another Group Set

BYet another group

v FIND FULL TEXT
> GROUPS SHARED BY OTHERS

v ONLINE SEARCH
@ PubMed (NLM)
@ Web of Science Core Collec...

more...

Search for group

File Edit References Groups Library Tools Window Help

0
0

Quick Search is often sufficient. Phrase
search (“”) and wildcards (*) can be
used. PDFs are searched as well!

Training

multicentennial

—~

X Clear search

Organising your Library — Searching Your Library

The advanced search box allows to
search for Boolean combinations of
various fields, such as author, year,
title, keywords, etc

R AL g

Endnote

_dit

PDF

— ey

X

Advanced search

Searching Training
1 Reference

B [/ UX X

Q

A

Author

Year Title Reference Type Journal

Esper, J...

20... Low-frequency signals in long tr... Journal Article

Science ]l

Abstract

Preservihg multicentennial clinate
variabilit = cords

is critically important for
reconstructing the full range of
temperature variability over the
past 1000 years. This allows the
putative "Medieval Warm Period"
(MWP) to be described and to be
compared with 20th-century
warming in modeling and
attribution studies. We
demonstrate that carefully
selected tree-ring chronologies
from 14 sites in the Northern
Hemisphere (NH) extratropics can

analysis are used. In addition, we
show that the average of these
chronologies supports the large-

o Tip: Imported references often have the fields <Keywords> already populated. You might even
consider adding your own keywords to references as they are all searchable.

urrence of the MWP over
extratropics.

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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M/ Lib4RI Archive the whole library or just groups or
Organising your L|brary —_ Backup 1group sets, incl. attachments into one file

EndNote 20 - Training Library.enl

l Wiit References Groups Library Tools Wi . Qicmrz O uutih Az it
New... () Create & E-mail (O without File Attachments
Open Library... Ctrl+QO .
Open Shared Library... Ctrtl+Shift+O f o
(®) All References in Library: Training Library.enl
Open Recent
Close Crl+W | Selected Reference(s)
Close Library ) () All References in Group/Group Set: My Group Set
.
Save
Save As... Next Cancel
Save a Copy...
Share... ‘
Export...
Import B
Print... «- v P « Temp » 7z EN_20 _drafts v (9] £ Search zz_EN_20 drafts
Print Preview - A

<

File name: ‘ Training Library_backup.enlx

Print Setup...

Save as type: EndNote Compressed Library (*.enlx)
Compress Library (.enlx) ... J

<

Exit

v Browse Folders Save Cancel

o Tip: When compressed ENLX-files are re-opened, EN regenerates the original *.ENL file
and *.DATA folder
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MV Lib4RI

Introduction to EndNote

EN’s GUI

o Create a new library (11)

o Graphica&lnterface (12)
Collect

o EndNote’s built-in online search (16)
o Export / import after an external database search (19)
o Import metadata from PDFs (24)

o Manually Jding & altering references (25)
o Find & at full text PDFs (27)

Organise
o Building groups (31)
Checking & Updating references (32)

Finding ¢ Bdlicates (33)
Searchin&ences (incl. PDFs & annotations) (34)

Backing up your library (35)

(@)

(@)

(@)

(@)

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Endnote

Cite
o Bibliographic output styles (37)
o Cite-while-you-write
(MS Word) (42)
o Using journal abbreviations (46)

Share & Sync

o Without EN Online Account (50)
Share references via E-mail
Share travel library via Word plugin
Share library as a compressed library or via servers
o With EN Online Account (53)
Sync between your devices
Share entire library
Share groups
Concluding Info, Help & Useful Links

o EndNote can do more (58)
o Is EndNote the right thing for me (59)

o User Guides & Tutorials, Support / Knowledge Base,
Community, FAQ (61)

O® 3%



M'LibsRl  Cite — Bibliographic Output Styles Endnote

o Output styles determine how references will be formatted and displayed in your bibliography or in your
text document

o EN’s <Style Manager> provides >6000 styles (incl. demands for most journals)

Select your favourite styles so they will
Salel NIV e accessible in EN’s main menu Via EN’s Style Manger (Tools > Output

File Edit Tools Window Help Styles > Open Style Manager) you can
o select favourite styles & preview

| | Name _ Category o get more styles
|:| Haematologica Hematology )
_@ Harvard Multidisciplinan: @) ed|t StyleS

r Harvard (NUIG) Science ] | |
| Health Ed Behavior Psychology

| [T Health Quality Life Out Public Health e

] Get More on the Web... Mark All Unmark All Findby » |

| 2 |ess Info: Style Info/Preview Edit

|
Billoski, T. V. (1992) Introduction to Paleontology, 6th ed., New York: Institutional Press. 2

Morehouse, S. |. and Tung, R. S. (1993) Statistical evidence for early extinction of reptilgs due to
the K/T event. Journal of Paleontology, 17(2), pp. 198-209. \l‘\e
PLe
Schwartz, M. T. and Billoski, T. V. (1990) Greenhouse hypothesis: effect on dinosaur extinction. in
Library for the Researd Jones, B. T. and Lovecraft, N. V., (eds.) Extinction,New York: Barnes and Ellis. pp. 175-189. H1O)
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M'LibiRl  Cite — Bibliographic Output Styles Endnote

o With EN’s <Style Editor> you can make many style adjustments effecting
layout & formatting of all <reference types> (eg book, journal article, etc)

o Tip: EN’s style editor is very powerful and can require a fair bit of training to get
used to the rules and special characters that effect the formatting of your
citations/bibliography.

o Tip: If you want to create/alter a style

o Using EN’s style manager, find & select the one closest to your liking and open it
with EN’s style editor

o Save the style under a different name and tag it in the style manager as a favourite

o Select the style in EN’s main menu

o Make changes to the style according to EN’s help (F1) and observe the effects for a
selected reference in the summary/preview pane of EN’s main window (after saving)

o EN’s manual on modifying reference types and output styles (X8 but still ok)
https://clarivate.libguides.com/ld.php?content id=33224848 (\Windows)
https://clarivate.libguides.com/ld.php?content id=33224873 (Mac)
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MV Lib4RI

Harvard (NUIG) Copy

File Edit lools Window Help

Plain Size ‘ ‘

Cite — Bibliographic Output Styles

Small changes such as the display of

Plain Font
| About this Style “ | Page Number Format
i+~ Punctuation

S O Don't change page numbers
TS

[l Page Numbers llShowonlv the firstoage qumber (e 1220
| e (®) Abbreviate the last page number (e.g. 123-5)
| ~Sections reviate the [ast page, keeping two digits (e.g. 123-25)

[=I Citations
I =

~Templates O Show the full range of pages (e.g. 123-125)

! - ~Ambiguous Citations
Author Lists
~Author Name
~Numbering
Sort Order
El Bibliography
~Templates
Field Substitutions
~Layout
~Sort Order
Categories
-~ Author Lists
- Author Name

O Show only the first page for journals, full range for others

page numbers are rather straightforward.

Training

B .., 2009 #.] Summary

Advanced search

Training

10 References

PR AR )

Author Year Title

Chong, M. N,; Ji.. 2010 Recent developments in photo

Cai, J.; Ruffieux, ... 2010 Atomically precise bottom-up f]

Malato, S.; Fern... 2009 Decontamination and disinfecti

Clifford, Sarah E;... Complexation of constrained lic

Budny, Eugeniu... Construction Machinery
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EN installs the tab <EndNote 20>
into the MS Word menu

H ©- v Document1 - Word
File Home Insert Design Layout References Mailings Review View [RASI\GIPIM Acrobat () Tellm Neuhol... ,Qi_ Share
|,, | N Go to EndNote Style:  Harvard (NUIG) Copy ~ |_Exs Categorize References ~ Export to EndNote - o
Q I’ Edit & Manage Citation(s) E..l Update Citations and Bibliography Instant Formatting is On ~ Manuscrpi-Matcha °
Insert —-— Hel
CitZ:iZn B 3¢ Edit Library Reference(s) ECDnved Citations and Bibliography ~ —= Preferences P
Citations L Bibliography Tools A

« EN’s Word plugin acts as an interface between EN and MS Word

» Either use <Insert Citation> from within the Word document or drag’'n drop
selected citation(s) from EN to the desired position in the document

« By default, EN activates <Instant Formatting>, i.e. citations and bibliography are
automatically formatted (or updated every 30sec) according to the selected
<Style

o Tip: Particularly if the document becomes rather large it is better to use the
unformatted citations (via <Convert Citations and Bibliography>) and turn off
<Instant Formatting> during the writing process.
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etc of your bibliography
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Cite — Using Journal Abbreviations

o Some journals require the journal title to be
abbreviated in the bibliography

For a specific style, this is
indicated at <Journal Names>

File Edit Tools Window Help

Plain Font Plain Size ‘ ‘

| About this Style “ ﬁournal Name Format \ al
|~ Punctuation

- Anonymous Works (O use full journal name

. ((Page Numbers
() Abbreviation 2
Nl e
() Abbreviation 3
= Citations O
Don't replace
~Templates o k )

<

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

I Y . T T

(®) Abbreviation 1

<

o The full title and up to 3 abbreviations for
journals can be defined in a so called
journal <Term List>

o EndNote

o by default, copies the content of the
reference field <Alternate Journal> as
<Abbreviation 1> into a linked journal
<term list>.

o allows the import of built-in journal
<term lists> (ASCI| files)

o allows to generate your own user
defined journal <term list> (ASCII file)

o Method a) is the most straight forward one
Method b) is particularly useful to save time
with large amounts of citations
Method c) might require lots of manual
editing
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Cite — Using Journal Abbreviations (Method a)
JThis is what your journal term list ...and this after editing the L
Term Lists might look like (Library > Open Term = Liof @bbreviations ] %
Lists > Journal Term List)
Terms Lists Terms Lists
3 Journals in the Journals List: 3 Journals in the Journals List:
Full Journal Abbreviation 1 Full Journal Abbreviation 1
Journal of Materials Chemistry 1 Mater Chem New Term... Journal of Materials Chemistry 1. Mater. Chem. New Term...
Science Science . Science Science )
Water Research Water Research B e Water Research Water Res. LS
Delete Term Delete Term
Insert Term Insert Term
< > < >
Hint: Hold the Ctrl key to select multiple terms Hint: Hold the Ctrl key to select multiple terms
Close Close
o Tip: If you are having troubles finding ‘correct’ abbreviations see
https://www.lib4ri.ch/journal-directories-useful-websites#Journal-Title-Abbreviations
o Tip: Save your journal term list (*.txt) for future use, expansion or simply as a backup
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Introduction to EndNote

EN’s GUI

o Create a new library (11)

o Graphica&lnterface (12)
Collect

o EndNote’s built-in online search (16)
o Export / import after an external database search (19)
o Import metadata from PDFs (24)

o Manually a:ding & altering references (25)
o Find & at full text PDFs (27)

Organise
o Building groups (31)
Checking & Updating references (32)

Finding duplicates (33)
Searchin&ences (incl. PDFs & annotations) (34)

Backing up your library (35)

(@)

(@)

(@)

(@)
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Endnote

Cite

o Bibliographie output styles (37)
o Cite-while?&ﬂte
(MS Word

o Using journal abbreviations (46)

Share & Sync

o Without EN Online Account (50)
Share references via E-mail
Share travel library via Word plugin
Share library as a compressed library or via servers
o With EN Online Account (53)
Sync between your devices
Share entire library
Share groups
Concluding Info, Help & Useful Links

o EndNote can do more (58)
o Is EndNote the right thing for me (59)

o User Guides & Tutorials, Support / Knowledge Base,
Community, FAQ (61)
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...via e-mail (one
Trainipg-Libranzan! reference at a time)

File Edit IRGEIENEN Groups Library Tools Window Help
nce Ctrl+N | . .
Edit Reference Ctrl+E [aining i
... formatted according to your style,
Copy References To 4 .
oo Strie incl. attachments
E-ma eference | |= Esper 2002 reference from ... ' Tl |
File Attachments » rainin fMessage | Insert Options Format Text Review Adobe PDF & @
Find Full Text 9
Find Reference Updates P References ) é [E9] IEI hd
URL 4
Figure » Author Paste Basic | Mames Include| Tags
= Text = - - -
Web of Science ' Chong, M. N.; Clipboard Zoom
Reference Summary
& Just something to show Cai, J.; Ruffieu From = info@lib4ri.ch
BTraining Malato, S.: Fel = —
Vv Yet another Group Set send
Clifford, Sarah Cc...
& Yet another group
Budny, Eugen Bec...
v FIND FULL TEXT
> GROUPS SHARED BY OTHERS Freedman, Dz Subject: Esper 2002 reference from my EndMote library
~ ONLINE SEARCH Milne, W. 1 Te | Attached: L Esper-2002-Low-frequency signals in long tree-.pdf |
®PubMed (NLM) . ( A ) &
A — Neyens, E. B2 1. J. Esper, E. R. Cook, F. H. Schweingruber,
b o science L-ore Lollec. _ Low-frequency signals in long tree-ring
more... chronologies for reconstructing past
entais temperature vanability. Science 295, 2250-
2233 (2002). doi: 10.1126/science 1066208
\ S
i =
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Library for the Reseaﬂ

Sharing without an EN Online Account

H oS- .

e atibility Mode] - Word = = |

% Categorize Reterences - | 12] Export to EndNote = n
Instant Formatting is Off ~ Export Traveling Library

pR =ctLibrary> using the Word Plugin

F",' Edit ez manage citanongs) T upaate CitaTons ana sinograpny

E'g.Edit Library Reference(s) E'\Convert Citations and Bibliography -

Insert

Citation ~ @3 Export Word Citations

Citations Bibliography ) @3 Export Word Master List

|_|‘9.|‘1.\.2‘ v3 0 4 R V8 1+ 9. 10 V111 120 1 13 L L e e e L e e o C A

Training Text

_ Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce posuere, magna sed
~ pulvinar ultricies, purus lectus malesuada libero, sit amet commodo magna eros quis urna. Nunc viverra imperdiet enim.

File Hom e export an EN <Trave”|ng r Vie\ cobat  (? Tellm: Neuhold, B.. Q. Share

.

- Fusce est. Vivamus a tellus. (Esper et al. 2002, Freedman et al. 2007, Milne et al. 2004) "

Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Proin pharetrg

- pede. Mauris et orci. Aenean nec lorem. In porttitor. Donec laoreet nonummy augue. (Budny et al. 2009)

eleifend. Ut nonummy. Fusce aliquet pede non pede. Suspendisse dapibus lorem pellentesque magna. Integé

Export Traveling Library

Export Library to:

: Suspendisse dui purus, scelerisque at, vulputate vitae, pretium mattis, nunc. Mauris eget neque at sem vene I () An existing EndMote library:

o (Chong et al. 2010) Training Library

™~ —
—

; Bibliography

i@ A new EndMote library

_ Budny, E., Chtosta, M., Meyer, H. J. and Skibniewski, M. J. (2009) Construction Machinery. in Grote, K.-H. and
o E. K., (eds.) Springer Handbook of Mechanical Engineering,Berlin, Heidelberg: Springer Berlin Heidelb)
1149-266.

L10 .

Chong, M. N., Jin, B., Chow, C. W. K. and Saint, C. (2010) Recent developments in photocatalytic water treatment
technology: A review. Water Res., 44(10), pp. 2997-3027 (Doi 10.1016/j.watres.2010.02.039).

S

- Esper, J., Cook, E. R. and Schweingruber, F. H. (2002) Low-frequency signals in long tree-ring chronologies for
reconstructing past temperature variability. Science, 295(5563), pp. 2250-3 (Doi 10.1126/science.1066208).

12,

Freedman, D., Pisani, R. and Purves, R. (2007) Statistics, International student edition, 4th , international student ed.,
New York: W.W. Norton & Co.

13

14

Milne, W. |., Teo, K. B. K., Amaratunga, G. A. J., Legagneux, P., Gangloff, L., Schnell, J. P., Semet, V., Binh, V. T. and
- Groening, O. (2004) Carbon nanotubes as field emission sources. J. Mater. Chem., 14(6), pp. 933-43 (Doi
10.1039/b314155¢).

15 .

Page 1of 1 274 words [# French (Switzerland) E B - ] + 110%

Browse...

[ Ok, ] [ Cancel

J

Help ]

...an EN library is created from
the citations in the Word
document (no attachments)
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Sharing without an EN Online Account

Share your library (or groups thereof) by using
EN’s compress library feature

o The entire library or just groups incl. attachments can be
compressed in one single file (refer to backup)

Share your library via an institutional server

o Put your library on a shared server
o One person at a time has full access

o Note that this can corrupt your library if the server has an
outage

Don’t share and sync your library via Dropbox
and other Cloud services

o  Your library will eventually become corrupted. This is NOT
recommended by EndNote at all!

Should your library get corrupted

o EndNote offers a repair tool with limited capabilities via
Library > Recover Library
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Endnote

hare & Sync using your EN Online Account (Classic) open your EN 20721

Sign in to continue with EndNote

Email address

Sign up for EndNote Online (classic) at
www.myendnoteweb.com

Please enter a valid email address.

Password

(o]

Please enter a password

Forgot Password?

orsigninusing o @

By signing in, you acknowledge and agree to our Terms of Use and Privacy Statement.

Not a member yet?

Need help? Contact EndNote Customer Care.

- Change Case

- Display Fields

. splay Fonts

- Duplicates

- Find Full Text

- Folder Locations
- Formatting

- Libraries

- PDF Handling

- Read / Unread

- Reference Types

- Sorting

eck

.. Term Lists
.. URLs & Links

library and enter your
details at Edit >
smeonze your e 2 FE€fEIENCES > Sync

Uparade or create your two+year EndMote account to get the latest features
and enable Sync.

EndMote Account Credentials

E-mail Address: Iinfo @libdri ch

Password: I

Sync this EndMate Library

“Mibdriwork$Proje.. \Training Library enl

Sync Automatically

If you always work with one and
the same library, you can activate

Endiote Defaus | | Revett Pl <Gync Automatically>, or else

manually sync via Library > Sync

Library for the Reseal

o Tip: Important - Backup your library prior to enabling Sync

o Tip: Important - Should you have an account with Clarivate Analytics (alerts with Web of
Science, Researcher ID, etc), use your existing credentials to sign into EndNote Online

o Tip: Only one single library can be synced (incl. attachments, no smart groups)



http://www.myendnoteweb.com/

Endnote

Your EN Online account will
eventually contain all your references,
attachments & groups (taken from all
group sets). Depending on the size of
your library upload/sync might actually
take quite some time.

MV Lib4RI Share & Sync using your EN Online (classic)

| .

12 Clarivate
Analytics

EndNote

My References Collect Downloads

Organize Format Match Options

Quick Search Training
= I Search for l
E inl All My References v] IShOW 50 per page v] M Page ofl Lga] P M
% Search

Sort by:[First Author - Ao Z ~

O all Opage [Add to group... ~| Copy To Quick List Delete = Remove from Group

My References
All My References (10)
[Unfiled] (0)
Quick List (0)
Trash (0)

¥ My Groups
Just something to show (2)
Training (10)
Yet another group (1)

Groups Shared by Others
Bobby's publications (44)
My Publications (44)

Authorg

Budny, Eugeniusz

Cai, J.

Chong, M. N.

Clifford, Sarah E

Einstein, Albert

Year

2009

2010

2010

2009

1963

EP-V-TY

Title

Construction Machinery

Springer Handbook of Mechanical Engineering

Added to Library: 24 Feb 2022 Last Updated: 24 Feb 2022
Online Link+ Go to URL

W& ul

Atomically precise bottom-up fabrication of graphene nanoribbons
Nature

Added to Library: 24 Feb 2022 Last Updated: 24 Feb 2022

Online Link+ Go to URL

Wmé ul

Recent developments in photocatalytic water treatment technology: A review
Water Research

Added to Library: 24 Feb 2022 Last Updated: 24 Feb 2022

Online Link+ Go to URL

wmZ uh
Complexation of constrained ligands piperazine, N-substituted piperazines, and thiomorpholine

Australian journal of chemistry
Added to Library: 24 Feb 2022 Last Updated: 24 Feb 2022

mé ul

The evolution of physics the growth of ideas from early concepts to relativity and quanta
Added to Library: 24 Feb 2022 Last Updated: 24 Feb 2022
mZ ub

£, : [P ra ; -~ | : r ~ L e . o leilie,

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

o Tip: If you like to sync this library with another device (PC, Mac or iPad), create a new
library on that device, then enable and start syncing therein (max 3 for one account)
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MV Lib4R] Share & Sync from within Endnote (via your linked EN

Online Account)

[ . )

‘fou are sharing your library with 1 people out of a possible 14,

e

Share with Status
|I bobby. neuhold @ib4ri.ch Pending £+ 3

You can share your entire library including
attachments, groups etc with up to 1000 (200
for EN20) other colleagues that also have
Endnote and an EN Online account.

Invite More People

Enter email addresses separated by commas

bobby.neuhold @lib4ri.ch

Add a message: {optional)

o After the invitee accepts your

invitation (via e-mail) his sharing
status <Pending> changes to
<Member>; you can revoke the
membership at any time via %

o Read/write permissions can be

defined for individual members of
shared libraries.

o User changes are protocolled.

Although EN 20/21 allow sharing of
individual groups as well (right-click
on the group > share group), the
group will only be linked via an URL
to EN Online (no attachments)

éa_:

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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i i Endnote
Share & Sync USIng an EN On"ne AccountJ From within EN Online (classic), you can
2 Clarivate EndNote share specific groups (no attachments)

Analytics with an unlimited number of colleagues

that also have an EN Online account.

My References Collect Organize Format Match Options Downloads

Manage My Groups Others' Groups Find Duplicates Manage Attachments

Manage My Groups

My Groups+4 ::fn;:?;:c‘;i Share

Just something to show 2l O Rename Delete
Training 10] O Rename Delete
Yet another group il O Rename Delete

Tip: Groups shared via EN Online (classic) are only accessible via EN Online (classic)
Tip: EndNote Online (classic) is a fully functional Reference Manager with limited functionality.

Guides:

o www.endnote.com > Training
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MV Lib4RI

Introduction to EndNote

EN’s GUI

o Create a new library (11)

o Graphica&lnterface (12)
Collect

o EndNote’s built-in online search (16)
o Export / import after an external database search (19)
o Import metadata from PDFs (24)

o Manually a:ding & altering references (25)
o Find & at full text PDFs (27)

Organise
o Building groups (31)
Checking & Updating references (32)

Finding duplicates (33)
Searchin&ences (incl. PDFs & annotations) (34)

Backing up your library (35)

(@)

(@)

(@)

(@)

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

Endnote

Cite

o Bibliographie output styles (37)
o Cite-while%&ﬂte
(MS Word

o Using journal abbreviations (46)

Share & Sync

o Without EN Online Account (50)
Share references via E-mail
Share travel library via Word plugin

- Share library as a compressed library or via servers
o With EN i ccount (53)

Sync between your devices
Share entire library
Share groups
Concluding Info, Help & Useful Links

o EndNote can do more (58)
o Is EndNote the right thing for me (59)

o User Guides & Tutorials, Support / Knowledge Base,
Community, FAQ (61)
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EndNote can do more...

o Categorise bibliographies (e.g. for CVs)
o Cite within Powerpoint (plugin)

o Footnotes

o Built-in Word manuscript templates (for Be explorative

various journals)

o Handle figures and tables (for
referencing in Word)

o Repair broken libraries ...but never
0. without a backup
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Endnote

Is EndNote the right thing for me?

o A quick comparison sheet
(EndNote, Mendeley, Zotero) is
available for download
(www.lib4ri.ch/trainings)
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MR s EndNote the right thing for me?

7 orae
e
P o ,

i Article Talk
5 it
&
X .
WIKIPEDIA Comparison of reference management software o
o
‘The Free Encyclopedia From Wikipedia, the free encyclopedia 7 -
The following tables compare reference management software. ‘\a\S“‘D\ &

Main page
Contents Contents [nide]

Featured content 1 General

CrmeriEis 2 Operating system support
3 Exportfile formats
4Import file formats

5 Citation styles

6 Reference list file formats

Random article
Donate to Wikipedia
Wikimedia Shop

upperstISOOTEL orcnen
~ Interaction Hochoiset
Help 7 Word processor integration
About Wikipedia 8 Database connectivity
Community portal
Recent changes

Universitatsbibiothek
9 Password "protection” and network versions Technische Universitat Manchen

10 References

Contact page 11 Bibliography
12 External links -
> Tools Teuhtleal Unicersy o g
kaich
» Print/s rt
e General [edif

~ Languages &

B3 Inthe "notes" section, there is a difference between:

& Edit links » web-based, referring to applications that may be installed on a web server (usually requiring MySQL or another databa:

» centrally-hosted website

Latest

o Comprehensive comparisons

o Wikipedia > Comparison of reference management software

o Digital Collection Management TU Munich
(https://mediatum.ub.tum.de/1127579)

‘ Talk to colleagues. Which software do they use and why !

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL

‘v, A5, | Booker o
G@Bookeﬁd

Endnote

e sinAate (Juw/

“+@aftware Comparison - 8th Update (June 2020)

%
15
Spermile,
Eng$nds
aperpile
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MV Lib4RI

Help, User Guides & Tutorials

o Via EndNote Help you have access to

o the built-in EndNote help, “F1” (PDF
located in program folder)

o online training resources (tutorials,
online user manual, webinars)

o technical support, knowledge base,
community, programs updates, more
styles, ...

o  More via www.endnote.com

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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b =

Hide Back Forward Print

Contents |ndex Search

- @ Title Page

[2) Trademarks

@ Introduction

@ The EndNote Library
@ Working with Referenc
® Searching EndNote Re
@ Groups and Groups Se
@ Term Lists

@ Searching Online Data
@ Importing Reference D
@ Cite While You Write ir
® EndNote in PowerPoin
@ Cite While You Write ir
@ Format Paper

@ Independent Bibliograg
® Subject Bibliographies
@ Reference Types

@ Output Styles

@ Import Filters

@ Connection Files

@ Preferences

® EndNote Online

@ Web of Science Integr:
@ Installing EndNote File
® EndNote on Networks
@ Appendices

Endnote

Training Library.enl

File Edit References Groups Library Tools Window JgEs

Get Technical Support

EndNote Output Styles
© Sync Configuration | Check for Updates...
|| EndNote Community 1.
B All References Search Knowledge Base

" Training Text_start.docx - EndNote Training Portal N

L Recently Added EndNote online
e Download EndNote Plug-ins
=l Unfiled

| Activate EndNote i
WTrash | About EndNote 20 /

J
| &
A

Clarivate EndNote 20 User Help Guide

12 Clarivate” | EndNote”

Collect. Collaborate. Create. From anywhere.

Clarivate EndNote 20 User Help Guide

Windows v
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MV Lib4RI Endnote

Useful Links

o Downloads o Support / Knowledge Base,
Community, FAQ

o hitps://endnote.com > Support

o https://endnote.com/downloads

o User Guides, Help, Tutorials, o Do’s and Don’ts & more

Training Videos & Classes
o https://endnote.com > FAQ

o https://endnote.com > Support
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MV Lib4RI

Thank you!

Stephanie Hofmann, Bobby Neuhold
Lib4RI - Library for the Research Institutes within the ETH Domain:
Eawag, Empa, PSI & WSL

Uberlandstrasse 133 « 8600 Diibendorf
Forschungsstrasse 111 « 5232 Villigen
Zurcherstrasse 111 « 8903 Birmensdorf

T +41 58 765 57 00
info@lib4ri.ch
www.lib4ri.ch

Library for the Research Institutes within the ETH Domain: Eawag, Empa, PSI & WSL
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